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Digital Signature Guide
1. Purpose
The procedures described in this document provide a means for guiding project staff in the proper creation of documentation requiring digital (electronic) signatures.
A digital signature, like a conventional handwritten signature, identifies the person signing a document. Unlike a handwritten signature, a digital signature is difficult to forge because it contains encrypted information that is unique to the signer and easily verified. 

To sign a document, you must have a digital ID. The digital ID contains a private key and a certificate, also known as a public key. The private key adds the digital signature, and the certificate that you share with people who use it to validate your signature. All users on the VA network should have PKI (Public Key Infrastructure) to enable digital signatures and for encryption of e-mail.
2. Apply Digital Signatures to an Adobe Acrobat Document 
Adobe Acrobat allows the convenient creation of documents that can be digitally signed.  A disadvantage to the use of Adobe Acrobat to create and manage documents with digital signatures is the licensing costs. The creator of the document must use Adobe Acrobat Professional. Those who sign the document only need Adobe Acrobat Reader.

When you apply a digital signature, Acrobat uses a hashing algorithm to generate a message digest, which it encrypts using your private key. Acrobat embeds the encrypted message digest in the PDF, along with details from your certificate, an image of your signature, and a version of the document at the time it was signed.

2.1. Create a Form

NOTE: Adobe Acrobat Professional is required to create a form that can be digitally signed.
1. Create the document in Word
2. Open Adobe Acrobat Professional
3. Open the Word document as a form

4. Select Forms from the toolbar 
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5. Select Start Form Wizard
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6. Select Use an existing file from the Create or Edit Form pop up window and click the Next button
[image: image4.png]Greate or Edit Form

PDFForm

O 30 S )

(PDF, Word, Excel or other il type)
O Scan a paper form

O Create 3 PDF form from scratch

Online Form Using Adobe FormsCentral

(O Create or edit a form using the online application
EormsCentral.adobe.com





7. Click the Browse button, browse to the location of the Word document, click to select, and click the Open button in the Open pop up window
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8. Click the Next button in the Create or Edit Form pop up window
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9. Select Next. To import the document and display the Welcome to Form Editing Mode window
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10. Press OK 
11. In this example, Adobe has created an undefined field
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12. Right-click the Undefined field and select Delete from the drop down menu
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13. Click the Add New Field drop down arrow
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14. Select Digital Signature from the drop down list
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15. Choose a starting point, click the mouse, and drag to display a rectangle to define the Digital Signature field
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16. Type a title for the field in Field Name area
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17. Repeat these steps until you create all the desired Digital Signature fields
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18. Select Advanced from the menu
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19. Select Extend Features in Adobe Reader… from the drop down menu
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20. The Enable Usage Rights in Adobe Reader pop up window displays
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21. Click the Save Now button

22. Click the Close Form Editing icon
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23. Save the form

2.2. Create a Form in Adobe Acrobat X Professional
1. Create the document in Word

2. Open Adobe Acrobat X Professional
3. Click Create PDF Form or Online Form
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4. Select Use an existing file from the Create or Edit Form pop up window and click the Next button
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5. Click the Browse button, browse to the location of the Word document, click to select, and click the Open button in the Open pop up window
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6. Click the Next button in the Create or Edit Form pop up window
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7. Select Next. To import the document and display the Form Editing window
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8. Press OK 
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9. In this example, Adobe has created an undefined field
10. Right-click the Undefined field and Click Select All from the drop down menu
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11. Right-click the field again, point to the Edit menu, and click Delete
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12. In the Forms pane, click the Add New Field drop down arrow

13. Select Digital Signature from the drop down list
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14. Choose a starting point, click the mouse, and drag to display a rectangle to define the Digital Signature field
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15. Type a title for the field in Field Name area
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16. Repeat these steps until you create all the desired Digital Signature fields
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17. Select Close Form Editing from the Forms window
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18. On the File menu, point to Save As, select Reader Extended PDF, then click Enable Additional Features
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19. The Enable Usage Rights in Adobe Reader pop up window displays
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20. Click the Save Now button

21. Save the form

2.3. Digitally Sign a Form
NOTE: Adobe Acrobat Reader is required to digitally sign a form.
1. Display the form
2. Place your cursor in the desired field to select it

NOTE: The first time you attempt to electronically sign a document, you will be prompted to create your digital signature. See Add a Digital Signature for instructions.
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3. Click to digitally display the Sign Document dialog box
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4. Click the down arrow in the Sign As field

5. Select the appropriate certificate from the list
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6. Verify that the selected signature is valid
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7. Click the Info… button in the Sign Document window to display the details of the signature and to verify that the certificate has not expired

8. Click the OK button in the Certificate Viewer window
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9. Click the Sign button
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10.  The Save As pop up window displays
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11. Click the Save button

NOTE: Some contractors may have to insert a device in the USB port, if their digital signature is stored on that device, but it is preferred that all contractors have PKI (Public Key Infrastructure)  installed, or use a PIV card
12. Click the Save button

13. A pop up window displays requesting the password or PIN associated to the certificate

14. Enter your PIN (if using a PIV card) or password, if applicable, and click the OK button
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15. The digitally signed document displays
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16. The next person signing the documents repeats the exact steps 

17. Circulate the document to all those whose signatures are required

NOTE: Whenever a team member displays the document, Adobe verifies the signatures
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2.4. Create a Digital Signature
The first time you attempt to electronically sign a PDF file using Acrobat Reader, you will be prompted to set up your digital signature using the following steps:
1. Click the appropriate signature field
2. The Add Digital ID dialog box displays
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3. Click the New PKCS#12 digital ID file radio button

4. Click Next
5. Enter your personal information in the Add Digital ID pop up window
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NOTE: Enter the name you want to appear in the Signatures tab and in any signature field that you complete, and enter a corporate or organization name (if necessary) and an email address. The example shows Chris Jones for the name, Unit Name for the Organizational Unit, Organization Name for the organization name, and ChrisJones@va.gov for the email address. Ensure that you select a country/region. This example shows the default US - United States.
6. Select the default 1024-bit RSA in the Key Algorithm field
7. Select Digital Signatures and Data Encryption from the Use digital ID for drop-down list
8. Click Next
9. A new Add Digital ID pop up window displays

10. Accept the default file location or browse to your preferred location to save and safeguard your information
11. Enter a password in the Password and Confirm Password fields 

Note: Remember that the password is case-sensitive. Be sure to make a note of your password and keep it in a safe place. You cannot use or access your digital ID without this password. Your password cannot contain double quotation marks ([dp][dp]) or any of the following characters:

! @ # $ % ^ & * , | \ ; < > _ 
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12. Click Finish
13. Verify the location and file name in the Save As dialog box
14. Click Save
3. Apply Digital Signatures to a Microsoft Word Document 

Microsoft Word also allows the convenient creation of documents that can be digitally signed.  Using MS Word to create and manage documents with digital signatures has the advantage of eliminating additional licensing costs.
3.1. Create a Form

1. Create a Word document
2. Place the cursor at the desired location for the digital signature
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3. Select the Insert tab
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4. Click the drop down arrow beside the Signature Line field in the Text tab

[image: image49.png]53 Date & Time.

B 4 2=3w-q

Tt Quick Wordart Dro
a "9 bl Object ~

T Q

Equation Symbol

Symbols.

Inset a signature line that
spedifiesthe indvidual who must
sign.

Inserting 3 digtal signature
requires that you obtain a digital
ID, such as one from a cerified
Microsoft partner.





5. Select Microsoft Office Signature Line… from the choices

[image: image50.png]‘Add Signature Services




6. Click the OK button in the Microsoft Office Word pop up window
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7. Type the desired information in the fields in the Signature Setup pop up window and click to select or deselect options

[image: image52.png]Approval Signatures

‘This section is used to document the approval of the Project Management Plan during the Formal Review
The review should be ideally conducted face to face where signatures can be obtained ‘live” during the
review however the following

3. Jes/in the signature bloc
approval is provided and kej

hicating the signer’s

‘The following members of uired to sign. Please
e

—
s M
o

Before siging this document, verify that the content you
jare signing is correct.

py (] Allow the signer to add comments in the Sign dialog
‘Show sign date in signature ne

[ J[om )

REVIEW DATE: <date>

Signed:
< Deputy Assistant Secretar

Jice of Responsibiliy >





8. Click the OK button
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9. Repeat these steps for all signature fields you wish to create

10. Save the document

3.2. Distribute and Digitally Sign the Document through SharePoint

1. Upload the document to SharePoint

2. The signer then opens the document from SharePoint

NOTE: Open the document in read-only mode. Do not check out the document or open it for editing.
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3. The signer then places the cursor in the field to be signed

[image: image55.png]Signed: Date.
< Project Manager >

Signed: Date.
< Business Sponsor>

Geoffrey Frank





4. Right click to display a drop down menu and select Sign…
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5. Click the OK button in the Microsoft Office Word pop up window
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6. Type your name in the signature field or, if you have a stored picture file of your signature, click Select Image… in the Sign window
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7. Click the Change button to select the authorized PKI (Public Key Infrastructure) signature in the Sign window
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8. Select the authorized signature from the list in the Select Certificate window
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9. Click the View Certificate button to verify that you have selected the correct signature
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10. Ensure that the certificate is issued by Veterans Affairs and that it has not expired in the Certificate window
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11. Click OK to exit the Certificate window
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12. Click OK to exit the Select Certificate window 
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13. Click the Sign button
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14. Enter your PIN (if using a PIV card) or password, if applicable, and click the OK button

[image: image66.png]Actividentity

ActivClient

Please enter your PIN.





15. Click OK to exit the Select Certificate window
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16. Close the document

17. The next person signing the documents repeats the exact steps
18. If you review the version history within SharePoint you can see when signatures are added to the document
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NOTE: When every one has signed the document from the common location it can be opened and saved to another location (such as TSPR), but any edits to the document will invalidate all the signatures. Any changes to the document would require the approval of all the signees. 
